Essential Graphics/Design Concepts for Non-Designers

presented by

Ana Henke

Graphic Designer and Publications Supervisor
University Communications and Marketing Services
New Mexico State University
Discussion topics

• What is resolution?
• Understanding graphic/image formats (TIFF, JPG, EPS, etc.)
• What are good and bad image sources?
• What are CMYK and RGB?
• What is the difference between linked vs. embedded images/graphics?
• What are bleeds?
• When should you start thinking about binding your document?
• Tips to organize your electronic files
• Why are PDFs so important for printing?
• Basic design principles: legibility, alignment, repetition, and contrast
• Copyright and fair use
• Additional resources
Resolution

• The amount of information or pixels contained in an image.

• Resolution is measured in DPI (dots per inch) or PPI (pixels per inch). These are literally the number of dots or pixels that can be placed side by side in a line one inch long. The more dots or pixels, the better the clarity – the higher the resolution – of the image.
Dots Per Inch (DPI)

The image on the right shows you the actual DOTS that are used to print a photograph on a printing press.
Resolution: Why is it SO important for printing?

high resolution  low resolution
Resolution: How do you know when an image has high resolution?

Tip 1:

Photoshop, a photo editing software, allows you to open the image file and look up the resolution. It should be 300 dpi or higher.
Resolution: What if you don’t have Photoshop?

**Tip 2: Image is probably low resolution:**
- if the placed or inserted image is SO small you have to enlarge it.
- if the image’s file size is smaller than 500KB (kilobyte).

**Tip 3: Image is probably high resolution:**
- if the placed or inserted image fills the page
- if image is at least 1MB (megabyte)

**Tip 4: PC users can right-click an image then choose “properties” to see resolution.**
Resolution: Where can you find file size?

![File Explorer window](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Date Modified</th>
<th>Size</th>
<th>Kind</th>
</tr>
</thead>
<tbody>
<tr>
<td>agave americana-2.tif</td>
<td>1/4/07</td>
<td>2 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>agave americana-3.tif</td>
<td>1/4/07</td>
<td>2 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>agave americana-4.tif</td>
<td>1/4/07</td>
<td>2 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>agave americana.tif</td>
<td>1/4/07</td>
<td>1.9 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>agave lechugirilla-2.tif</td>
<td>1/4/07</td>
<td>2 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>agave lechugullien.tif</td>
<td>6/22/07</td>
<td>1.9 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>agave neomexicana.tif</td>
<td>1/4/07</td>
<td>2 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>agave parryi-2.tif</td>
<td>1/4/07</td>
<td>2 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>agave paryle.tif</td>
<td>1/4/07</td>
<td>2 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>allanthus altissima.tif</td>
<td>12/7/06</td>
<td>664 KB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>aloe baubadensis-2.tif</td>
<td>1/4/07</td>
<td>2 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>aloe baubadensis.tif</td>
<td>1/4/07</td>
<td>1.8 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>Artemisia ...idiana.tif</td>
<td>6/25/07</td>
<td>3 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>Asclepias tuberosa.tif</td>
<td>12/14/06</td>
<td>992 KB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>Asclepias t...a leaves.tif</td>
<td>12/14/06</td>
<td>996 KB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>astriplex c...ens fruit.tif</td>
<td>1/4/07</td>
<td>1.9 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>atriplex canescens.tif</td>
<td>1/4/07</td>
<td>2 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>cistus pai.tif</td>
<td>12/18/06</td>
<td>948 KB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>cistus purpures.taf</td>
<td>12/18/06</td>
<td>928 KB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>cistus purpuresus.tif</td>
<td>12/18/06</td>
<td>940 KB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>codatevia sellowara.tif</td>
<td>1/4/07</td>
<td>2 MB</td>
<td>Adobe...IFF file</td>
</tr>
<tr>
<td>Cypsohili...niculata.tif</td>
<td>12/14/06</td>
<td>932 KB</td>
<td>Adobe...IFF file</td>
</tr>
</tbody>
</table>

aces.nmsu.edu/pubs/ • twitter.com/NMExtensionPubs • facebook.com/NMSUExtExpStnPubs
Understanding Image formats

- **Raster images** (TIFF, JPEG, GIF, PNG, PICT, BMP): These types of images are composed of pixels and are dependant on resolution for clarity (photos, line art, etc.)

- **Vector images** (EPS): These types are images are not dependant on resolution and can be enlarged without distortion.
This example shows you how you can modify a vector file by extending some of the anchor points.
Good sources of image files

• **Digital camera images** set at the highest resolution setting.

• **Slides or photos** that you can scan yourself. *(Tip: Scan at 300 dpi and scale [enlarge] images to final desired size during scanning stage.)*

• **Downloadable high resolution images.** *(Always remember to look into copyright permission when using photos produced by a third party.)*
Scanning tips

• When scanning line art or text, set your scanner to black/white, NOT grayscale. Image will print much more clearly.

• Scan photos/slides at 300 dpi and line art at 900 dpi.

• Scale (enlarge) your images at this stage. Ex: If you have to scan a slide, scale (enlarge) it up to 300%. That will enlarge the image to 3 times its original size at 300dpi so it will be BOTH clear and larger.
Typical Scanning Setup

Output type

Resolution (dpi)

Scale
Downloadable high resolution images.
Downloadable high resolution images.

Bugwood.org
Example of our use of a Bugwood image in one of our publications.

**Figure 2.** Whitefringed beetle larva. Note the well-developed, slightly darker brown head capsule on the right; the chewing jaws; the multi-segmented, ivory-colored body; and the absence of legs. (Photo credit: Edward L. Barnard, Florida Department of Agriculture and Consumer Services, Bugwood.org)

**Figure 3.** Adult whitefringed beetle (actual length about 1/2 inch), so named because of the white markings on the edges of the gray-striped wing covers. Also note the elbowed antennae and the short, broad snout. (Photo credit: Pest and Diseases Image Library, Bugwood.org)

Adults live above ground, hide in plant debris, and feed by cutting small notches in the leaf margins of various plants. The flightless adults are transported accidentally.

Adults emerge from the soil April through October. Flood irrigation may force the beetles to leave alfalfa and take temporary refuge around homes, other buildings,
Bad sources of image files

• **Screen captures**
  Images on the Web are usually only 72 dpi.
  (Find out about copyright before using any online image, and be careful to not use images with watermarks.)

• **Cut or copied and pasted images**
  I do NOT recommend copying a pasting images from one software into another! The image quality will degrade every time this is done and the resolution is usually low.
What if the only photo you have is within a MS Word document?

I do NOT recommended copying/pasting images; however, if the clarity of the image looks good (by that I mean NO pixels) and the image is the only thing on the page, you can make a PDF of the page and insert the PDF into your document as a graphic. You can also print the image, scan it at 300 dpi and insert into your document as an image.

The quality won’t be as good as an original, high resolution image, but it may be adequate.
What if the only photo you have is within a PDF document?
If you have Photoshop, you can open the PDF, crop out the image and save the file as TIFF image. If you don’t have this software, you can print the page, scan it at 300 dpi and insert into your document as an image.

The quality won’t be as good as an original, high resolution image, but it may be adequate.
How to convert a PDF into a graphic file using Photoshop.

1. File > Open > filename.PDF. Make sure resolution is 300 dpi.
2. Select the photo with the Rectangular Marquee Tool.
3. Image > Crop
4. File > Save As > TIFF format
What image formats are best to use for print?

• **TIFF format** is preferred by the print industry for photos, etc.
  – If your project is going to be printed on a printing press all images need to be converted to CMYK mode.

• **EPS, AI format** is preferred for illustrations.
What is CMYK and what is RGB?

The **CMYK color model** stands for Cyan, Magenta, Yellow and black. When a color photo is printed it is literally separated into these four colors and printed one color at a time. These four colors then combine to give you the full color image.

When a photograph is going to be reproduced on a traditional printing press or on today’s digital presses or color printers, photos should be converted to CMYK format prior to reproduction to ensure color accuracy.

The **RGB color model** stands for Red, Green and Blue. Files in RGB format are intended for use on electronic systems like TVs, mobile phone displays and computer monitors.

You’ve probably noticed that the colors of photos on different electronic devices often look different—that is because each device reads the color breakdowns differently. You don’t want this type of inconsistency in print.
How do I change a file from RGB to CMYK to prepare file for printing?

The only way to change a file from RGB to CMYK format is to use Photoshop.

You would go to Image > Mode > CMYK Color.

Also, remember to save the file in TIFF format.

If you don’t have this software, pre-press staff at your print shop will need to make the change for you.
Linked vs. Embedded images

- Placing or inserting your images **LINKS** them to the document. Pasting them in **EMBEDS** them.

  - **Links** establish a connection from one file to another, without significantly increasing the document file size.

  - **Embedding** literally puts one file into another, often significantly increasing the document file size.
Why is embedding images a BAD idea?

• Embedded images are usually low resolution.
• You CAN’T modify embedded images.
• When all images are embedded, it is sometimes difficult to print a document.
• Embedding images increases the size of the document more than when they are linked.
What are bleeds?

A bleed is when an image extends beyond the edge of the paper and excess is trimmed off.
Crop marks (highlighted) let the print shop staff know where the paper should be trimmed. These were generated by Adobe InDesign.
If you don’t have a design software, you can still set up a project to allow for bleeds. The easiest way to do that is to place your text and images on the page with wide enough margins (.25 to .5 inch) that will give the print shop staff enough space to trim excess content from the image to give you the bleed you want.
What is binding and when should you start thinking about it?

Binding is how the pages of your print project are assembled. You should start thinking about it as soon as you start working on your project—so you can adjust margins for the desired binding option. We’ll be discussing the three most common types of binding: saddle stitch (staple) binding, spiral binding and perfect binding.
Saddle-stitch (staple) binding

Tips
• Margins should always be set to at least .75 in. The bigger the document the wider the margins need to be (if saddle stitching is the preferred binding.) Remember you only have so much space to work with!

• You need to worry about creep (excess paper beyond trim line) if your document has over 60 pages (or 30 sheets, back/back)

• Consider other types of binding if your document is over 80 pages long (or ~40 sheets, back/back).
Spiral binding

Perfect binding

Remember
Creep is NOT an issue in either of these types of binding. **But it is a good idea to use wide margins on your documents**—preferably .75 in. **or higher**. The inside margin should be wider than the outside margins to allow for spiral binding and to allow easier reading on large documents.
How to organize your files.

• **Main software file (native file):** Adobe InDesign, Publisher, MS Word, PowerPoint *(Note: we recommend using professional design software whenever possible!)*

• **Image/graphics folder:** TIFF, JPEG, GIF, PNG, PICT, BMP, EPS

• **Fonts folder** *(This can be generated automatically if you are using a professional design software.)* If you don’t know how to access your fonts, I recommend that you use standard fonts found in most computer systems in your designs. This will limit the amount of text shifting that may occur when the pre-press staff at your print shop works with your file. *(EX: Times New Roman, Garamond, Helvetica, Arial, etc.)*

• **PDF of document**

NOTE: Putting all of these files and sub-folders in ONE folder will make it easier for your software to locate the images when the file is opened. This will also make your job and the print shop’s staff job easier when printing your project.
Example of how to organize your files.
Why are PDFs so important NOW?

- PDF (Portable Document Format): These files are basically a fixed electronic image of your publication.

- PDFs are now preferred by most print shops to produce color copied projects AND press run projects because using this one single file—that contains everything—is much easier to process than needing to work with all of the individual elements that you used to build your publication.

- How to create a PDF: The software you are using to build your print project (also known as native file) usually allows you to make a PDF easily by using the “Save As” option or from the “Print” option.
Graphic Design Basics

• **Legibility** (If you can’t read it, what’s the point?)

• **Alignment** (Headings, photos, column content, etc.)

• **Repetition** (Try to use ONLY two fonts, one for your headings and one for your body text, use the same color scheme throughout, same sized photos/charts & graphs).

• **Contrast** (Font headings should be larger than text font; contrast in text color and background enhances legibility!)

• **Use high-quality images, charts or graphs.**
HURRICANE KARL BATTERS MEXICO AS IT NEARS LANDFALL
POWERFUL HURRICANE KARL BATTERED THE CARIBBEAN COAST OF MEXICO ON FRIDAY, BRINGING TORRENTS OF RAIN AND FIERCE WINDS SEVERAL HOURS BEFORE ITS CENTER WAS EXPECTED TO MAKE LANDFALL.

Hurricane Karl batters Mexico as it nears landfall. Powerful Hurricane Karl battered the Caribbean coast of Mexico on Friday, bringing torrents of rain and fierce winds several hours before its center was expected to make landfall.

Which is easier to read?
The lack of **contrast** between background photos and font colors affects **legibility**.
The better the contrast, the more legible the text.
Alignment is demonstrated beautifully in this example by how the subheads are aligned to the left margin of the columns, while the text is indented. This sets the paragraphs off nicely and draws the eye down the page and onto the next column. Also, notice how the text from both columns align with each other.

Repetition is demonstrated by the repeated use of color in the sub-headings and consistency and limitation of font choices in the layout.

Contrast is demonstrated by the larger font size of the subheading and the black text on white and light yellow boxes, as well as the reversed out text on crimson.
Maintain **alignment** by using grids. Repeat fonts and color scheme and create **contrast** by varying font sizes.
Copyright and Fair Use

Copyright can be a confusing subject, but you can stay on the right side of the law by following a couple of easy rules.

Public Domain
Works in the public domain are not protected by copyright and may be freely reproduced. The two biggest categories are US Government works and works produced before 1923.

Even though they are not copyrighted, you should still provide a citation when reproducing public domain works.

Copyrighted Works
If a work is copyrighted, you may be able to reproduce it if your use can be considered “fair use.” Fair use can be tricky to determine, though. To be on the safe side, always request permission (in writing) from the work’s owner or copyright holder to reproduce any copyrighted work. If you’re unsure about whether a work is copyrighted, just assume that it is.
Additional Resources

Graphic Design
• *The Non-Designer’s Design Book* by Robin Williams
• *Design Basics Index* by Jim Krouse
• *Layout Index* by Jim Krouse
• Thinking With Type website: [http://www.thinkingwithtype.com/](http://www.thinkingwithtype.com/)

Sources of public domain or copyright-free images
• Center for Invasive Species and Ecosystem Health [http://bugwood.org/](http://bugwood.org/)
• NOAA Photo Library [http://www.photolib.noaa.gov/](http://www.photolib.noaa.gov/)
• Creative Commons [http://creativecommons.org/](http://creativecommons.org/)
Questions and Answers

Thank you for participating in today’s webinar! We hope you’ve found it useful.

If you have follow-up questions, feel free to email me directly at ahenke@nmsu.edu.